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Introduction 
 
Bienvenue dans Flame Painter. 
 
Flame Painter est un logiciel de peinture unique qui vous permet de créer facilement des 
graphismes originaux, des effets de lumière, des dessins particuliers ou de fantastiques arrière-
plans avec des jeux de lumières. 
 
Il a été créé dans le cadre d’un projet expérimental de la série « Je suis un artiste ». L’objectif 
initial était de créer une application avec laquelle tout le monde puisse créer quelque chose de 
beau. Elle a été pensée pour être autant un outil pour les artistes que pour les personnes sans 
talent artistique qui voudraient créer quelque chose d’unique. 
 
Le manque d’inspiration et de motivation sont souvent les raisons pour lesquelles les gens ne 
sont pas créatifs, néanmoins, les outils que nous utilisons peuvent devenir une source 
d’inspiration. Je pense qu’avec des outils qui vous inspirent, tout le monde peut être un artiste.  
C’est pourquoi Flame Painter est né. 
 
C’est la 3ème version de Flame Painter. Elle offre beaucoup de nouvelles possibilités telles que 
Flame Painter Connect - un plugin Photoshop qui agit comme un lien direct entre Flame Painter 
et Photoshop, donne la possibilité d’utiliser les stylets à pression des tablettes Wacom et les 
caméras Leap Motion et permet l’import/export de fichiers PSD avec des calques et de fichiers 
vectoriels SVG. Un moteur multi-cœur, un nouveau moteur de rendu haute-résolution et de 
nouveau modes de compatibilité avec Photoshop font de ce logiciel un puissant outil pour la 
création de design professionnels. 
 
Ce manuel explique les possibilités du logiciel et vous explique ce que vous devez savoir pour 
commencer à peindre. Il y a toute une série de paramètres de pinceaux. Expérimentez 
simplement différents réglages et vous trouverez peut-être une toute nouvelle voie 
d’expression. 
 
Merci d’avoir acheté Flame Painter. J’espère que vous prendrez plaisir à peindre ! 
 
 
 Peter Blaškovič 
         Créateur de Flame Painter 
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Fenêtres d’interface utilisateur 
 

Fenêtre Outils 
 

 Pinceau - Sélectionne l’outil pinceau  

 Crayon - Sélectionne l’outil Crayon 

 Gomme - Sélectionne l’outil Gomme 

 Remplissage - Sélectionne l’outil remplissage  

 Transformation - Déplace et redimensionne le 
calque sélectionné 

 Edition de calque vectoriel - Edition du calque 
vectoriel sélectionné 
 

 Zoom arrière - Réduction de l'affichage (jusqu’à 
une taille minimum de 5% de l'original). 

 Zoom avant - Agrandissement de votre travail 
(jusqu’à 800% de l'original). 

 Réinitialiser le zoom - Contrôle la 
valeur de zoom. Pressez le bouton pour revenir à 
100%. 

 Annuler - Annule la dernière action 

 Rétablir - Rétablit la dernière action annulée. 
 

Pinceau 
 
Il existe trois modes de peinture différents : 
Flamme - Mode de dessin classique de Flame Painter. 
Suivi - Le contour suivra la souris plus précisément, un pinceau basé sur des lignes 
Ruban - Mode de dessin en ruban, un contour dispersé un peu plus largement 
 
Blending (Mode de fusion) - Modes de fusion des couleurs. Il y a trois modes de fusion:  
- Normal pour le dessin standard,  
- Lumineux (synthèse additive) est habituellement utilisé pour des effets de lumière et des 
fonds sombres,  
- Sombre (synthèse soustractive) pour des fonds clairs. 
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Opacity (Opacité) - Opacité du pinceau (0 - 100) 
 
Paramètres des pinceaux Flame, Suivi et Ruban 
 
Voici les paramètres de l’outil pinceau que vous pouvez essayer: 
 

Size (Taille) - Taille du pinceau - nombre de points du pinceau (1-300) 
Span (Largeur) - Largeur du pinceau (0 - 10) 
Distance - Distance entre les points du pinceau (1 - 20) - Vous pouvez régler ce paramètre si 
l’option "Lignes" est active. 
Soft (Douceur) - Douceur du pinceau (1 - 100) - effet plus global sur le pinceau 
Speed (Vitesse) - Vitesse du pinceau (1 - 100) - temps de réaction du pinceau, plus la vitesse est 
grande, plus le pinceau est précis 
Center (Centrer) - Forces Globales (0 - 100) 
Focus (Mise au point) - Forces Locales (0 - 100) 
Chaos - Paramètre très chaotique (0 - 100) - comment les points du pinceau oscillent 
chaotiquement autour du pinceau 
Noise (Bruit) - Paramètre de bruit (0 - 100) - plus le nombre est grand, plus le pinceau aura de 
bruit. 
 
Tous ces paramètres sont en corrélation. Chacun influence ce à quoi le pinceau ressemblera. 
 
Fade (Fondu) - Fondu du pinceau en entrée/sortie (0-10). Règle le temps de fondu. 
 

Remplir |Ligne - Changer entre les modes “remplir” et “lignes”. 
 

Detail (Précision) - Précision du pinceau (1-4). Règle la précision du contour de la flamme, donc 
la qualité des détails. A utiliser si l’on veut un contour finement détaillé, ou en cas de toile de 
grande taille.  
Note: En sélectionnant des paramètres plus élevés, les opérations peuvent être ralenties car 
l’ordinateur doit effectuer plus de calculs. 
Antialiasing (AA) - Changer entre “Antialiasing Normal” et “Antialiasing Super fin” 
Note: En cas de sélection du paramètre “Antialiasing Superfin”, l’application peut être ralentie 
car cela implique une plus grande charge de calcul que “Antialiasing Normal”.  
Cette fonctionnalité n'est disponible que dans la version Pro. 
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Crayon 
 
Règle les paramètres de l’outil Crayon : 
 
Blending (Mode de fusion) - Modes de couleur. Il y a 
trois modes de couleur:  
- Normal pour le dessin standard,  
- Lumineux (synthèse additive) est habituellement 
utilisé pour des effets de lumière et des fonds sombres, 
- Sombre (synthèse soustractive) pour des fonds clairs. 
Size (Taille) - Taille de l’outil Crayon (1-200) 
Hardness (Dureté) - Dureté de l’outil Crayon (0-100) 
Step (Pas) - Pas d’application de l’outil Crayon (0-100) 
Opacity (Opacité) - Opacité du crayon (0 - 100) 
 

Utiliser uniquement avec une couleur. Les dégradés ne sont pas disponibles avec cet outil. 
 
 

Gomme 
 
Règle les paramètres de l’outil gomme : 
 
Size (Taille) - Taille de la gomme (1-200) 
Hardness (Dureté) - Dureté de la gomme (0-100) 
Step (Pas) - Pas de l’application de la gomme (0-100) 
Opacity (Opacité) - Opacité de la gomme (0-100) 
 
 
 
 
 
 

Remplissage 
 
Vous pouvez remplir le calque avec l’option “Couleur” 
ou "Dégradé" de la fenêtre Palette. Si vous choisissez le 
dégradé, vous pouvez l’appliquer verticalement ou 
horizontalement. 
 
Vertical | Horizontal - Changer entre un remplissage 
"Vertical" ou "Horizontal". 
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Transformer le Calque 
 
Déplace et change la taille du calque sélectionné. 
Cliquez OK pour accepter les changements, ou Annuler 
si vous changez d’avis. 
Si vous désirez transformer et éditer un Calque 
Vectoriel (disponible en version Pro), cliquez le bouton 
"Editer le Calque Vectoriel". 

Editer le calque vectoriel - Edition Pro 
 
Outils peinture - Dessiner un nouveau chemin. Vous 
pouvez peindre un chemin sur un calque vectoriel. 
Outils d’édition - Editer un point de référence (point 
jaune) et modifier le vecteur ainsi créé. Cliquez sur un 
point (gris) pour le transformer en point de référence 
(jaune). 
Outils d’édition groupé - Editer un groupe de points de 
référence (points jaunes). 
Outils d’ajout et de retrait - Retirer un point éditable 

de votre chemin. (Raccourci: Ctrl sous Windows / Cmd sous Mac OS) 
Transformation de courbe - Redimensionner et tourner un tracé.  
Transformation de courbe initiale - Redimensionner et tourner un tracé initial. 
 
Les calques vectoriels ont le grand avantage de pouvoir éditer les chemins peints. Dans un 
calque vectoriel, vous pouvez peindre un chemin que vous pourrez ensuite transformer et 
éditer. Après avoir dessiné un chemin, vous pouvez changer tous les paramètres de pinceau : le 
mode de couleur, l’opacité, la couleur et le dégradé voire changer complètement les 
préréglages de pinceau. C’est un mode d’édition très flexible si vous voulez modifier les 
paramètres pour trouver le pinceau parfait. 
 
Note: Lors de la création d’un nouveau contour dans un calque vectoriel, le précédent est 
supprimé. Un nouveau calque pour chaque contour éditable est recommandé. 
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Fenêtre Palette 
 
Color | Gradient (Couleur | Dégradé) - Choisir si vous voulez peindre ou remplir le calque avec 
une couleur ou avec un dégradé. 
 

Color (Couleur) 
 
Choisissez la couleur de votre pinceau. 
 
H (T) - Teinte du pinceau (0-359) 
S - Saturation du pinceau (0-255) 
L - Luminosité du pinceau (0-255) 
 
Palette - sélectionner la couleur du pinceau 
 
(+) (-) - ajouter et retirer des couleurs personnalisées. 
 
Un clic sur la boîte de couleurs ouvre une palette de 
sélection. La couleur que vous utilisez pour peindre en 
mode Lumineux ou Sombre peut apparaître légèrement 
différente de ce que vous voyez dans "couleur du 
pinceau". C’est propre à l’application et aux modes 
Lumineux / Sombre. Si vous désirez avoir la couleur 
exacte, choisissez le mode Normal. 
 

Gradient (Dégradé) 
 
Choisissez et réglez votre dégradé.  
Cliquez sur le la couleur que vous voulez changer et 
sélectionner la couleur désirée dans la palette. Vous 
pouvez activer/désactiver les couleurs que vous voulez 
utiliser dans le dégradé. 
 
Rotation - Tourner le dégradé. 
Inverser - Inverser le dégradé. 
 
H | S | L - Change la teinte, la saturation et la 
luminosité pour toutes les couleurs du dégradé. 
 
Length (Longueur) - Choisit le dégradé en longueur ou 
en largeur du pinceau et en choisir la longueur (1-10). 
Plus le nombre est grand, plus les couleurs changent 
fréquemment. 

 
(+) (-) - Ajouter et retirer des couleurs et dégradés des listes.  
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Fenêtre Pinceau 
 

Fenêtre de préréglages de pinceau, vous permettant 
d'ouvrir ou de sauvegarder vos réglages de pinceau. 
 
Use brush palette (Utiliser la palette) - Utiliser la 
palette des pinceaux sauvés  
Use blend mode (Utiliser le mode de fusion) - Utiliser le 
mode de couleur (normal, lumineux or sombre) qui est 
sauvegardé dans le pinceau. 
Share brush (Partager le pinceau) - Télécharger votre 
pinceau vers Brushes Gallery (la galerie de pinceaux en 
ligne). Cliquez Oui pour confirmer. 
 
(+) (-) - Ajouter et retirer des préréglages de pinceau de 
la liste. 
 
Pour ajouter un préréglage de pinceau, cliquez “Ajouter 
un pinceau” (+), créez votre propre icône de pinceau, 
entrez le nom du pinceau et cliquez sur Sauvegarder. 
Un nouveau pinceau apparaitra immédiatement dans le 
menu. 

 
Note: En enregistrant un pinceau en mode Sombre, seul le fond blanc est disponible. En 
enregistrant un pinceau en mode Lumineux, seul le fond noir est disponible.  
 
Pour télécharger d’autres pinceaux gratuits, cliquez sur le lien ci-dessous. Vous pourrez ensuite  
glisser-déposer de nouveaux pinceaux directement de la page web dans la fenêtre de Flame 
Painter:  
http://www.escapemotions.com/products/flamepainter/brushes/index.php 
 
Note: Certains navigateurs ne permettent pas de  transférer les métadonnées des pinceaux. Si le 
glisser-déposer depuis le navigateur ne fonctionne pas, essayez d’utiliser un navigateur 
différent, ou téléchargez le pinceau depuis le lien ci-dessus vers le dossier de votre ordinateur 
qui peut être trouvé du menu de Flame Painter: "Aide" -> "Afficher le dossier des pinceaux" -> 
"Pinceaux". Tous les pinceaux se trouvant dans le dossier “Pinceaux“ apparaitront dans le 
Fenêtre des pinceaux. 
Les informations sur le glisser-déposer et le téléchargement des pinceaux peut être trouvé dans 
la FAQ du site web:  
https://www.escapemotions.com/products/flamepainter/support.php 
  

http://www.escapemotions.com/products/flamepainter/brushes/index.php
https://www.escapemotions.com/products/flamepainter/support.php
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Fenêtre Calques 
 

Utilisez la fenêtre des calques pour les éditer et les 
manipuler. 
 
Blending (Mode de fusion) - 22 modes de couleur 
Photoshop : Normal, Sombre, Multiplicatif, Couleur 
brulée, Brulé linéaire, Lumineux, Ecran, Dodge de 
couleur, Dodge linéaire, Superposition, Lumière 
doucet, Lumière forte, Lumière vive, Lumière linéaire, 
Lumière fixe, Mix dur, Différence, Exclusion, Teinte, 
Saturation, Couleur, Luminosité et mode soustractif. 
Opacity (Opacité) - Règle l’opacité du calque (0-100) 
Œil - Afficher ou cacher le calque actif (à côté de l’icône 
du calque). 
Effacer le calque - Effacer le contenu du calque 
(raccourci: Suppr). 

 
Nouveau calque - Ajouter un nouveau calque. 
Nouveau calque vectoriel - Ajouter un nouveau calque vectoriel éditable. Cette fonctionnalité 
n'est disponible que dans l’édition Pro.  
 
Dupliquer le calque - Dupliquer le(s) calque(s) actif(s). 
Fusionner les calques - Fusionner plusieurs calques en un seul. 
Supprimer le calque - Supprimer le(s) calque(s) actif(s). 
 
Vous pouvez renommer un calque actif en double-cliquant dessus dans la liste des calques. 
Vous pouvez convertir un calque vectoriel en Bitmap depuis le menu. 
 
Les fenêtres Palette, Pinceaux et Calques sont détachables - il est possible de changer leur 
position et d’ajuster leur taille. 
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Barre de Menus 
 
File (Fichiers) - Contient les éléments relatifs à l’ouverture, l’enregistrement, l’exportation et la 
publication de vos œuvres. 
Edit (Edition) - Contient les éléments relatifs à l’édition de dessins ainsi qu’à la toile. 
Layer (Calques) - Contient les éléments relatifs aux calques. 
Filter (Filtres) - Contient les éléments relatifs au filtrage et aux effets additionnels sur l’image. 
View (Affichage) - Contient les éléments relatifs à l’affichage ainsi qu’à l’interface. 
Window (Fenêtre) - Contient les éléments relatifs à l’interface utilisateur. 
Help (Aide) - Contient les éléments vous permettant d’obtenir de l’aide pour l’application, ou 
pour rechercher des mises à jour sur le site web. 

 
 

Menu File (Fichiers) 

 
Le menu fichier contient les éléments relatifs à votre peinture. Ils fonctionnent comme suit : 
 
New… (Nouveau...) - Ouvre une boite de dialogue qui vous permet de créer de nouveaux 
dessins avec de nouveaux réglages.  
Open… (Ouvrir...) - Ouvre une fenêtre qui vous permet de charger un dessin enregistré. 
Save (Enregistrer) - Enregistre votre dessin. Si vous ne l’aviez pas encore enregistré, un nom 
vous sera demandé. 
Save as… (Enregistrer sous…) - Enregistre une copie de votre dessin actuel sous un nouveau 
nom. 
 
Import… (Importer…) - Ouvre une image dans un nouveau calque. L’image est 
automatiquement redimensionnée à la taille du canevas actuel, mais il est possible d’en 
changer la taille et la position. 
 
Export layer to SVG… (Exporter le calque en SVG…) - exporter le calque vectoriel actif en tant 
que polygones dans format de graphiques vectoriels éditables (SVG). Réglez le nombre de 
polygones avec la glissière Détail de 1 à 4. 
Cette fonctionnalité n'est disponible que  dans l’édition Pro. 
Exemple : si le calque vectoriel est composé de 100'000 polygones et Détail est réglé sur 1, le 
rendu sera de 100'000 polygones. Si Détail est réglé sur 2, cela va quadrupler le nombre de 
polygones, qui sera donc de 400'000. Si le réglage est de 3, le nombre de polygones sera de 
1'600'000 et s’il est de 4, le résultat sera 6'400'000 polygones. 
 
Publish… (Publier…) - Publie votre dessin dans la Flame Painter Gallery. Entrez un nom pour 
votre dessin; ainsi qu’une description et des tags, si désiré.  
Publish Preferences… (Préférences de publication…) - Un sous-menu contenant les préférences 
de Gallery 
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Preferences (Préférences…) - Paramétrer une Bordure de Sécurité, une Tablette Wacom et 
Leap Motion 
- Safe boundary (Bordure de sécurité) - Vous pouvez paramétrer un canevas étendu avec une 
surface visible plus grande que le canevas. Activer et désactiver la visibilité et régler la taille et 
l’opacité d’une Bordure de sécurité 
- Wacom tablet (Tablette Wacom) - Réglages pour travailler avec des tablettes supportant la 
sensibilité à la pression. Vous pouvez régler l’intensité des paramètres qui doivent être 
influencés par la pression sur la tablette. 
- Leap Motion - Réglages pour les périphériques Leap Motion. Cela permet de dessiner en 
utilisant le contrôle gestuel d’une main. Sélectionnez la Touche Maj pour dessiner avec un 
doigt et utilisez la touche "Maj" comme le bouton d’une souris, ou sélectionnez Montrer Deux 
Doigts pour dessiner avec deux doigts. 
 
Quit (Quitter) - Ferme l’application. (Uniquement sous Windows) 
  
Pour plus d’informations sur la création, le chargement et l’enregistrement de vos dessins, 
reportez-vous à la section “Création, chargement et enregistrement de dessins” plus loin dans 
ce manuel. 
 

Menu Edit (Edition) 

 
Undo (Annuler) - Annule les dernières opérations effectuées. Le nombre d’opérations 
annulable dépend de la mémoire de votre ordinateur. Le nombre maximum est 100. 
Redo (Rétablir) - Rétablit les dernières opérations annulées. 
 
Image size… (Taille de l’image…) - Un sous-menu contenant la largeur et la hauteur en pixels de 
l’image redimensionnée ainsi que la bordure de sécurité en pourcentage. 
Exemple : Si vous créez une image avec une taille de 1200 x 1200 pixels et la Bordure de 
Sécurité est réglée sur 10%, la Bordure de Sécurité sera de 120 pixels. 
 
Cocher Keep aspect ratio (Conserver le Ratio)  si vous désirez redimensionner l’image avec le 
même ratio hauteur/largeur que l’image actuelle. 
 
Exemple : Si la largeur de l’image actuelle est de 1200 pixels, la hauteur est de 800 pixels et 
vous voulez lui donner une largeur de 2400 pixels avec le même ratio, enclenchez Conserver le 
Ratio et le logiciel calculera la dimension manquante - 2400 x 1600 pixels 
 
Note : Veuillez vous assurer d’avoir sauvegardé votre travail avant de redimensionner votre 
image. La fonction Annuler n’est pas disponible après le redimensionnement d’une image. 
 
Copy (Copier) - Copier un calque vers n’importe quel logiciel tiers qui supporte les images avec 
canal alpha dans le presse-papier. 
Paste (Coller) - Coller une image du presse-papier (de n’importe quel logiciel tiers) dans le 
calque. 
 
Vous pouvez aussi glisser-déposer des images directement vers Flame Painter 3 depuis 
n’importe quel logiciel ou navigateur internet, pour autant que l’application le supporte. 
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Les outils suivants ne sont utilisables qu’avec les calques vectoriels, le reste du temps, ils sont 
grisés.  
Ces fonctionnalités ne sont disponibles que dans la version Pro. 
 
Paint tool (Outil de dessin) - Permet de dessiner un nouveau tracé. Vous ne pouvez dessiner 
qu’un seul chemin sur un calque vectoriel. 
Edit tool (Outil d’édition) - Permet d’éditer les points de référence (points jaunes) et modifie 
ainsi le vecteur. Cliquez sur les points (gris) pour les transformer en points de référence (jaune). 
Group edit Tool (Outil d’édition groupé) - Permet d’éditer un groupe de points de référence 
(points jaunes). 
Add / Remove tool (Outil d’ajout/suppression) - Permet de retirer des points de votre chemin. 
(Raccourci : Ctrl sous Windows / Cmd sous Mac OS) 
Curve transform (Transformation de courbe) - Permet de redimensionner, tourner et ajuster la 
taille d’un chemin de pinceau.  
Init curve transform (Transformation de courbe initiale) - Permet de redimensionner, tourner 
et ajuster la taille d’une courbe initiale. 
 
 

Menu Layer (Calques) 

 
New layer (Nouveau calque) - Ajoute un nouveau calque. 
New vector layer (Nouveau calque vectoriel) - Ajoute un nouveau calque vectoriel (disponible 
uniquement dans la version Pro).  
Duplicate layer (Dupliquer calque) - Duplique le(s) calque(s) actif(s). 
Merge layers (Fusionner calques) - Fusionne les calques sélectionnés en un seul. 
Delete layer (Supprimer calque) - Supprime le(s) calque(s) actif(s). 
 
Show layer (Afficher calque) - Affiche ou cache le calque actif. 
Transform layer (Transformer calque) - Déplace et redimensionne le calque actif 
Clear layer (Effacer calque) - Efface le contenu du calque. 
 
Export to Photoshop (Export vers Photoshop) - Exporte le calque avec ses réglages, le mode de 
couleur et l’opacité de Flame Painter vers Photoshop. 
Vous pouvez trouver plus d’informations à propos de Flame Painter Connect - le Plugin 
Photoshop plus loin dans ce manuel. 
 
Convert to bitmap (Convertir en bitmap) - Convertit un calque vectoriel en calque bitmap 
(disponible uniquement dans la version Pro). 
 
Hires render… (Rendu haute résolution…) - Règle le Détail de Rendu Haute-résolution (1-5). Un 
Rendu Haute-résolution est un rendu polygonal. L’espace entre les points est rempli, rendant 
l’image plus lisse, sans l’apparence d’un effet moiré. Ce ne peut être utilisé qu’avec les calques 
vectoriels. 
Quand le rendu haute-résolution est terminé, l’image ainsi créée remplacera le calque courant. 
“HQ“ apparait dans le Fenêtre du haut, signifiant “haute qualité”. Quand des modifications 
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additionnelles sont apportées au calque rendu, HQ disparaît et le calque vectoriel doit être à 
nouveau recalculé.  
 
Presser la touche Echap pour annuler le rendu. Veuillez patienter jusqu’à ce que le processus 
s’arrête. 
 
Disponible dans la version Pro 
 
Note: le Rendu Haute résolution génère une importante charge de calcul, le rendu d’un calque 
vectoriel peut nécessiter jusqu’à quelques heures. Le temps de rendu dépend fortement de la 
longueur du pinceau ainsi que des réglages du paramètre "Taille". Plus le coup de pinceau et la 
Taille sont grands, plus le rendu nécessitera de temps.  
 
Exemple: Si le calque vectoriel est composé de 100 000 polygones et le Détail de Rendu Haute-
résolution est réglé sur 1, le rendu peut se faire en 1 minute. S’il est réglé sur 2, cela 
quadruplera le nombre de polygones, qui sera donc de 400 000 et il faudra alors 4 minutes. Si le 
réglage est de 3, le nombre de polygones sera de 1 600 000et le temps nécessaire sera de 16 
minutes. S’il est sur 4, le nombre sera de 6 400 000, allongeant le temps de rendu à 64 minutes. 
Si enfin le réglage est sur 5, le nombre de polygones atteindra 25600000, le rendu prendra donc 
256 minutes, soit plus de 4 heures. 
 
 

Menu Filter (Filtres) 
 
Blur (Flou) - Ouverture d'une fenêtre permettant de régler la taille de la zone de flou. 
- Aperçu - Affiche ou cache le résultat en temps réel. 
Glow (Eclat) - Ouverture d'une fenêtre permettant de régler le rayon de l’éclat et la brillance. 
- Aperçu - Affiche ou cache le résultat en temps réel. 
 
Tile layer (Empilement des calques) - Empile les calques soit horizontalement, soit 
verticalement. 
 
 

Menu View (Affichage) 

 
Zoom in (Zoom avant) - Agrandit votre image (jusqu’à un grossissement maximum de 800%). 
Zoom out (Zoom arrière) - Réduit votre image (jusqu’à un minimum de 5%). 
Zoom 100% - Zoom variable à l’aide du curseur. Cliquer sur le bouton pour réinitialiser 
l'affichage à 100%. 
Show safe boundary (Affichage Bordure de sécurité) - Active ou désactive l'affichage de la 
bordure de sécurité 
Show cursor (Afficher Curseur) - Affiche ou masque le curseur. 
Show brush dots (Afficher les points du pinceau) - Affiche ou masque les points du pinceau. 
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Menu Windows (Fenêtres) 

 
Tools (Outils) - Affiche ou cache la fenêtre outil 
Palette - Affiche ou cache la fenêtre de palette 
Brushes (Pinceaux) - Affiche ou cache la fenêtre pinceaux 
Layers (Calques) - Affiche ou cache la fenêtre calques 
 
Stay on top (Rester au premier plan) - Le programme va toujours rester au premier plan. 
Fullscreen (Plein écran) - Flame Painter est affiché en plein écran. (Cliquez sur Echap pour 
sortir). 
Show main menu (Afficher menu principal) - Affiche ou masque le menu principal (Cliquez sur  
Echap pour sortir). Uniquement sous Windows, sous Mac OS, le menu principal est caché 
automatiquement. 
 
 

Menu Help (Aide) 

 
Help (Aide) - Ouvre ce document. 
Send feedback… (Envoyer un commentaire…) - Envoyez-nous un commentaire si vous avez un 
problème, des idées ou simplement si vous appréciez le programme. Entrez votre adresse e-
mail et votre message. 
Flame Painter website (Site Web de Flame Painter) - Lien vers le site web: 
http://flame.escapemotions.com 
About Flame Painter (A propos de Flame Painter) - Informations de base sur Flame Painter, le 
copyright et les crédits. 
 
Show brushes folder… (Afficher le dossier des pinceaux…) - Affiche le dossier où les pinceaux 
sont enregistrés. 
Online brush library… (Bibliothèque de pinceaux en ligne…) - Affiche la bibliothèque en ligne 
avec des pinceaux à télécharger. 
 
Check for updates… (Vérifier les mises à jour…) - Ce bouton est visible quand de nouvelles 
mises-à-jour sont disponibles 
Upgrade to Pro edition (Mettre à jour vers la version Pro) - Cliquez si vous désirez passer de la 
version Personnelle à la version Professionnelle. Disponible dans l’édition personnelle. 
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Flame Painter Connect 
 

Flame Painter Connect est un plugin pour Photoshop CS5, CS6 et Photoshop CC. C’est un 

moyen de communication entre Photoshop et Flame Painter 3 Pro pour le transfert de calques 

entre ces applications. 

 

Installation 

Votre pack d’installation contient 3 dossiers: 

Mac OS 

Windows 

Photoshop plugin 

 

Installation pour Photoshop CS5 & CS5.5 

 

Copier le fichier "Flame_Painter_Connect_1.2.swf" du dossier "Photoshop plugin" vers le 

dossier d’installation de Photoshop: 

- Windows 32 bits: C:\Program Files (x86)\Adobe\Adobe Photoshop CS5\Plug-ins\Panels\ 

- Windows 64 bits: C:\Program Files\Adobe\Adobe Photoshop CS5 (64 Bit)\Plug-ins\Panels\ 

- Mac OS: /Applications/Adobe Photoshop CS5/Plug-ins/Panels/ 

 

Installation pour Photoshop CS6 & CC 

 

Etape 1: Ouvrir le dossier “Photoshop plugin” et double-cliquer sur le fichier 

"Flame_Painter_Connect_1.2.zxp". Si le fichier n’est pas associé à Extension Manager 

automatiquement, ouvrir votre Extension Manager et choisir dans le menu: Fichier -> Installer 

une extension. 

 

Etape 2: La fenêtre "Extension Disclaimer" s’ouvre - cliquer “J’accepte”. 

Etape 3: Une fenêtre annonçant que le publicateur ne peut pas être vérifié s’ouvre - cliquer 

“Installer”. 

Etape 4: Dans le cas où vous avez plus d’un produit ou extension Adobe installés sur votre 

ordinateur, une nouvelle fenêtre peut s’ouvrir, vous demandant de choisir pour quelle version 

de Photoshop vous voulez installer le plugin. 
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Si Extension Manager n’est pas installé sur le système, ou l’installation du plugin n’est pas 

valide, copier manuellement le fichier "Flame_Painter_Connect_1.2.swf" vers le dossier 

d’installation Photoshop: 

- Windows 32 bits: C:\Program Files (x86)\Adobe\Adobe Photoshop CS6\Plug-ins\Panels\ 

- Windows 64 bits: C:\Program Files\Adobe\Adobe Photoshop CS6 (64 Bit)\Plug-ins\Panels\ 

- Mac OS: /Applications/Adobe Photoshop CS6/Plug-ins/Panels/ 

 

Comment démarrer Flame Painter Connect 

 

Etape 1: Démarrer Photoshop et Flame Painter 3 Pro 

Etape 2: Dans Photoshop créez un nouveau document 

depuis le menu: Fichier -> Nouveau... 

Etape 3: Dans Photoshop cliquer dans le menu:  

Fenêtre -> Extensions -> Flame Painter Connect. Une 

nouvelle fenêtre Flame Painter Connect apparait à droite 

de l’écran. 

 

 
Comment exporter des calques 

 

Exporter de Photoshop vers Flame Painter 

Sélectionner un calque que vous voulez exporter vers Flame Painter et cliquer sur le bouton 

“PS vers FP”.  

Si vous sélectionnez un calque vide dans Flame Painter, un calque de Photoshop sera exporté 

vers ce calque vide sinon, un nouveau calque sera créé. 

 

Exporter de Flame Painter vers Photoshop 

Sélectionner un calque que vous voulez exporter vers Photoshop et cliquer sur le bouton "PS" 

dans le Fenêtre Calques, ou dans le menu: Calque -> Exporter vers Photoshop (Raccourci Ctrl-F 

sur Windows, Cmd-F sur Mac OS). Si vous sélectionnez un calque vide dans Photoshop, un 

calque de Flame Painter sera exporté vers ce calque vide sinon, un nouveau calque sera créé. 

Les calques exportés gardent leur nom original. La plupart des modes de couleur gardent aussi 

leurs préréglages originaux. 
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Comment garder la même taille de toile dans Photoshop et Flame Painter 3 Pro 

 
Option 1:  Démarrer Photoshop.  

Quand vous exportez le calque Photoshop, l’application Flame Painter 
s’ouvrira avec la taille du calque exporté. 

 
Option 2:  Démarrez Photoshop et Flame Painter 3 Pro.  

Quand vous exportez le calque Photoshop et qu'il y a un nouveau document 
auquel aucun changement n’a été apporté dans Flame Painter, le nouveau 
document sera redimensionné à la taille du calque exporté.  

 
Option 3:  Démarrez Photoshop et Flame Painter 3 Pro. 

Ouvrez Flame Painter Connect dans Photoshop. En exportant le calque 
depuis Flame Painter, le nouveau document sera créé dans Photoshop avec 
la taille du calque exporté.  

 
Option 4:  Réglez manuellement la taille de la toile dans les 2 applications. 
 
 
Note: Si le message suivant apparait lorsque vous travaillez avec Flame Painter Connect, 
contrôlez si Flame Painter et Photoshop sont en cours de fonctionnement. 
 

 
 
Si tout est réglé correctement, ce message pourrait apparaître en exportant depuis Photoshop 
et signifie que cela prend trop de temps à Photoshop pour effectuer la requête. Cliquez “OK“ et 
attendez quelques secondes l’apparition dans Flame Painter de l’image exportée.  
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Création, ouverture et enregistrement de dessins 
 

Création d’un nouveau dessin 
 

Pour créer un nouveau dessin, sélectionnez l’option New… (Nouveau...) du menu fichier. La 
fenêtre nouveau fichier apparaît. Cette fenêtre vous permet de régler la taille de votre 
nouveau dessin et de paramétrer laa toile laquelle vous allez dessiner. La taille peut aussi être 
réglée durant le dessin. Dans la section "Picture size info" (Info sur la taille de l’image) vous 
pouvez contrôler la taille de l’image à l’impression.  
Le bouton Background layer vous permet de sélectionner la couleur de l’arrière-plan, y 
compris le choix des préréglages de fond Noir et Blanc.  
 

Finalement, cliquez OK pour créer un nouveau dessin ou Cancel (Annuler) si vous en décidez 
ainsi. 
 

Ouverture d’un dessin 
 

Pour ouvrir un dessin, sélectionnez l’option Open… (Ouvrir...) du menu fichier. Cette fenêtre 
vous permet d’ouvrir une image ou une œuvre précédemment enregistrée et de régler les 
propriétés.  
 

Finalement, cliquez OK pour ouvrir le dessin, ou Cancel (Annuler) si vous renoncez à l’ouvrir. 
 

Vous pouvez aussi glisser-déposer une image directement depuis n’importe quelle source - 
dossier, navigateur ou site web - et elle sera ouverte dans un nouveau calque. 
 

Enregistrement d’un dessin 
 

Pour sauvegarder votre dessin, utiliser l’option Save… (Enregistrer…) du menu fichier. Le 
format natif est un Fichier format FPA, qui contient toutes les informations sur votre œuvre et 
sur les calques. Utilisez ce format si vous voulez poursuivre le dessin plus tard.  
 

Avec Flame Painter 3 Pro, vous pouvez ouvrir et enregistrer des fichiers au format PSD avec 
des calques pour Photoshop, Gimp  ou d’autres logiciels bitmap supportant le format PSD - 
avec tous les paramètres de calque, modes de couleur et opacité. Il est possible d’exporter des 
calques vectoriels comme fichier vectoriel SVG pour Illustrator ou d’autres éditeurs de 
graphiques vectoriels, où vous pouvez constamment éditer vos images sous formes de 
vecteurs. 
 

Vous pouvez aussi choisir un format de fichier différent, mais certains peuvent ne pas contenir 
toutes les informations sur votre création et peuvent ne pas être ouverts correctement (la 
couleur de fond peut être différente ou la transparence pourrait ne pas être enregistrée dans 
le format JPEG).  
Si vous désirez enregistrer votre dessin avec des réglages particuliers ou dans un format qui 
puisse être lu par d’autres applications, utilisez l’option Save as… (Enregistrer sous...) du menu 
fichier. Cela vous permet d’enregistrer votre dessin au format PSD, PNG, TIF, BMP, ou JPG.  

Finalement, cliquez OK pour enregistrer le dessin ou Cancel (Annuler).  
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Publier une dessin dans la Galerie 
 

Création d’un compte Galerie 

 
Pour publier vos œuvres, vous devez premièrement créer un compte. Vous avez deux options 
pour créer un compte:  
 
Depuis l’application: 
Créez votre compte Gallery depuis le menu File -> Publish Preferences (Fichier->Préférences de 
publication) de Flame Painter. Entrez votre nom, E-mail ("Votre ID") et mot de passe et, si vous 
le désirez, un lien vers votre site web. 
 
Depuis le site web: 
Sur la page Gallery, cliquez login -> Create account (login -> Créer un compte) et entrez “Votre 
ID” (E-mail pour l’enregistrement). Vous recevrez un mot de passe que vous pourrez changer 
par la suite. 
Note: Vous trouverez "Votre ID" dans le menu Help -> About Flame Painter (Aide->A propos de 
Flame Painter). Si "Votre ID" n’existe pas, entrez votre E-mail actif. 
 
 

Publier une œuvre de Flame Painter vers Galerie 

 
Pour publier vos dessins, utilisez l’option Publish… (Publier...) dans le menu fichier. Entrez un 
Nom pour votre œuvre, une Description et des Tags pour votre image. Cliquez sur le bouton 
Publier. Votre image sera publiée sur la Gallery (www.escapemotions.com/gallery) ou vous 
pouvez éditer les images par la suite. 
 
 

Editer votre profil et vos œuvres dans Gallery 

 
Si vous avez déjà créé un compte, allez sur la page web de Gallery, cliquez login et entrez 
"Votre ID" et mot de passe. 
Dans la section Editer des images, vous pouvez éditer le nom, la description, les tags et 
d’autres paramètres de vos créations. 
Dans la section My Profile (Mon profil), vous pouvez changer votre mot de passe. 
 

  

http://www.escapemotions.com/gallery
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Raccourcis clavier 
 
 
 Windows Mac OS 

Nouveau...  Ctrl-N Cmd-N 

Ouvrir... Ctrl-O Cmd-O 

Enregistrer Ctrl-S Cmd-S 

Enregistrer sous... Ctrl-Maj-S Cmd-Maj-S 

Importer… Ctrl-Maj-O Cmd-Maj-O 

Publier... Ctrl-P Cmd-P 

Quitter Ctrl-Q Cmd-W 

 

Annuler Ctrl-Z Cmd-Z 

Rétablir Ctrl-Maj-Z Cmd-Maj-Z 

Copier Ctrl-C Cmd-C 

Coller Ctrl-V Cmd-V 

Exporter vers Photoshop Ctrl-F Cmd-F 

 

Pinceau Q Q 

Crayon A A 

Gomme E E 

Remplir F F 

Transformer T T 

Editer le calque vectoriel V V 

 

Augmenter la valeur +1 Up Up 

Diminuer la valeur -1 Down Down 

Augmenter la valeur +10 Pg Up Pg Up 

Diminuer la valeur -10 Pg Down Pg Down 

 

Effacer le calque Del Del 

 

Déplacer une toile Clique droit ou Barre d’espace + Clique gauche 

 

Zoom avant Ctrl - + Cmd - + 

Zoom arrière Ctrl - - Cmd - - 

Zoom 100% Ctrl - 0 Cmd - 0 

Zoom avant | arrière Roulement de souris ou Alt + Roulement de souris 

 

Quitter le rendu Haute Rés. Echap Echap 
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Bordure de sécurité Ctrl-B Cmd-B 

Afficher|cacher le curseur Alt-C Alt-C 

Afficher|cacher les points  

de dessin Alt-D Alt-D 

 

Plein écran Ctrl - L Cmd - L 

Afficher le menu principal Ctrl - M Cmd - M 

Aide F1 Cmd + ? 

 

Outil de dessin 1 1 

Outil d‘édition 2 2 

Outil d’édition groupée 3 3 

Outil d’ajout & suppression 4 4 

Transformation de courbe 5 5 

Transf. de courbe initiale 6 6 

 

Version Personnelle ou version Professionnelle 
 
La version personnelle est plus adaptée pour des utilisateurs qui veulent un outil de création 
complet, mais qui n’ont pas besoin d’utiliser de fonctions avancées et ne vendent pas d’image 
créée ou modifiée avec Flame Painter. La licence permet d’installer Flame Painter sur plusieurs 
ordinateurs pour un utilisateur pour une utilisation non-commerciale ou des activités à but 
non-lucratif. 
 
La version Professionnelle est mieux pour les professionnels et les utilisateurs qui ont besoin 
de fonctions avancées telles que calques vectoriels, le rendu Haute résolution ou d’un lien avec 
Photoshop. La licence permet d’installer Flame Painter sur un seul ordinateur pour des 
entreprises, ou sur plusieurs ordinateurs pour une seule personne. Cette licence permet 
l’utilisation du logiciel pour une utilisation commerciale ou des activités lucratives ainsi que 
pour des activités non-commerciales. 
 
Pour de plus amples détails, veuillez vous référer aux termes de la licence. 
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Copyright & Crédits 
 
 
Flame Painter © 2012-2015 Escape Motions, s.r.o 
Flame Painter © 2009-2012 Peter Blaškovič 
Flame Painter Connect © 2014 Escape Motions, s.r.o 
 
 

Team Escape Motions: 
 
Peter Blaškovič, Michal Fapšo, Veronika Klimeková, Andrea Vachová 
 
 

Remerciements particuliers à: 
 
Tous ceux qui ont contribué par des idées, des suggestions, ou qui ont aidé à finaliser Flame 
Painter, particulièrement à Jozef Bardík, Daniel Kapičák, Matúš Fedorko, Jaroslav Kaša, 
Rastislav Piovarči, Rastislav Hornák, Gabika Ambrušová, Cara, Daniel Innes, Oto Kóňa, Tomáš 
Lancz, Lukáš Lancz, Tomáš Mišura, Andrei Oprinca, Martin Surovček, Roman Urbášek, Harvey 
Bunda, Rana Diaz, Devraj Baruah, Dennis Kirkpatrick, Jim Kanter, Gregorii Trombo, Keith Alford, 
Josh Kitney, Nigel Brewster, Vladimir Chopine, Mark S. Johnson. 
 
Traduction et corrections: Tanya Hayman, Tony Lloyd, Daniel Streidt, Kenjiro Nagano, 
Higashiuchi Takuri, Kévin Jorand, Marta Fernandez, Irene Briz, Andy Chen, Serge Fleury, 
Veronika Klimeková, Andrea Vachová. 
 
Icônes de l’interface utilisateur: "Batch" par Adam Whitcroft 
 
 

Librairies utilisées: 
 
Cette application a été développée avec les librairies suivantes: 
 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 
CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
ImageMagick, Apache license - http://www.imagemagick.org/ 
AntiGrain Geometry 2.4, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html 
MB WebSockets, LGPL license - https://qt.gitorious.org/qtplayground/mbwebsockets 
 
 
Merci à Dieu pour toutes les idées créatives. 
  

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/
http://www.imagemagick.org/
http://agg.sourceforge.net/antigrain.com/index.html
https://qt.gitorious.org/qtplayground/mbwebsockets
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Contrat d’utilisateur final de Flame Painter 
 
 
Copyright 2012-2015 Escape Motions, s.r.o. Tous droits réservés. 
Copyright 2009-2012 Peter Blaškovič. Tous droits réservés. 
 
La traduction partielle ci-dessous est fournie à titre indicatif seulement, la version anglaise ci-
après fait foi. 
 
Cette licence est l’accord légal entre vous et Escape Motions pour l’utilisation du logiciel Flame 
Painter (le "Logiciel"). En téléchargeant, installant, copiant ou en utilisant le Logiciel d’une 
quelconque manière, vous reconnaissez avoir lu les termes et conditions de cette licence, les 
avoir compris et accepter d’être lié par ces termes. Si vous refusez d’accepter ces termes et 
conditions, Escape Motions n’accepte pas de vous licencier le Logiciel, et vous n’êtes par 
conséquent pas autorisé et ne devez pas utiliser le Logiciel. 
 
 
Utilisation permise 
 
Flame Painter Personnelle: 
 
Les utilisateurs de Flame Painter peuvent utiliser le Logiciel pour des activités personnelles, non-
commerciales et non-lucratives. 
Vous pouvez installer le Logiciel sur plusieurs ordinateurs pour autant que pas plus d’un de ces 
ordinateurs ne soit en utilisation simultanément et que ces ordinateurs soient réservés pour 
votre utilisation personnelle. 
 
Flame Painter Professionnelle: 
 
Les utilisateurs de Flame Painter peuvent utiliser le Logiciel pour des activités commerciales, ou 
lucratives aussi bien que pour des activités personnelles, non-commerciales et non-lucratives. 
Le logiciel peut être installé sur un ordinateur destiné à plusieurs utilisateurs mais ne peut être 
installé sur plusieurs ordinateurs, que ceux-ci fonctionnent simultanément ou non. 
Vous pouvez installer le Logiciel sur de multiples ordinateurs pour autant que pas plus d’un de 
ces ordinateurs ne sera utilisé simultanément et que ces ordinateurs sont destinés uniquement 
à votre utilisation personnelle. 
 
Vous ne pouvez enlever les notices de copyrights du Logiciel. Vous pouvez faire une (1) copie du 
Logiciel à des fins de sauvegarde ou d‘archivage. 
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Flame Painter End-User Software License 

Agreement 
 
 
Copyright 2012-2014 Escape Motions, s.r.o. All Rights Reserved. 
Copyright 2009-2012 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Flame Painter 
software (the "Software"). By downloading, installing, copying, or otherwise using the Software, 
you acknowledge that you have read terms and conditions of this license, understand them, and 
agree to be bound by them. If you do not agree with these terms and conditions, Escape Motions 
is unwilling to license the Software to you, and you are not authorized and may not use the 
Software. 
 
 
Permitted Use 
 
Flame Painter Personal: 
 
Users of the Flame Painter may use the Software for personal, non-commercial, or non-profit 
activities. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
Flame Painter Professional: 
 
Users of the Flame Painter may use the Software for commercial, or for-profit activities as well 
as for personal, non-commercial, or non-profit activities. 
The Software may be installed on a computer that is for multiple users but it may not be installed 
on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
 
Restrictions 
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty. This is a license, not a transfer of title, and unless you have been granted 
prior, written consent from Escape Motions you may not: 
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a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party. 
b, Sell, rent, lease, assign, or sublet the Software or portions thereof. 
c, Grant rights to any other person. 
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part. 
e, Use the Software in violation of any international law or regulation. 
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
 
 
Display of Copyright Notices 
 
All copyright and proprietary notices and logos within the Software files must remain intact. 
 
 
Indemnity 
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license. 
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. 
Peter Blaskovic may also make improvements and/or other changes to the Software at any time 
without notice. 
 
 
Disclaimer Of Warranty 
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT 
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE. 
 
 
Limitations Of Liability 
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH THE 
SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT 
NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
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PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 


